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Related Information

 Introduction to Altera IP Cores
Provides general information about all Altera IP cores, including parameterizing, generating,
upgrading, and simulating IP.
o Creating Version-Independent IP and Qsys Simulation Scripts
Create simulation scripts that do not require manual updates for software or IP version upgrades.
o Project Management Best Practices
Guidelines for efficient management and portability of your project and IP files.

Altera DSP IP Core Features

o Avalon® Streaming (Avalon-ST) interfaces

« DSP Builder ready

o Testbenches to verify the IP core

« [P functional simulation models for use in Altera-supported VHDL and Verilog HDL simulators

Reed-Solomon Il IP Core Features

Intel Corporation. All rights reserved. Intel, the Intel logo, Altera, Arria, Cyclone, Enpirion, MAX, Nios, Quartus and Stratix words and logos are trademarks of

Intel Corporation or its subsidiaries in the U.S. and/or other countries. Intel warrants performance of its FPGA and semiconductor products to current ISO
specifications in accordance with Intel's standard warranty, but reserves the right to make changes to any products and services at any time without notice. ~ 9001:2015
Intel assumes no responsibility or liability arising out of the application or use of any information, product, or service described herein except as expressly Registered
agreed to in writing by Intel. Intel customers are advised to obtain the latest version of device specifications before relying on any published information

and before placing orders for products or services.

*Other names and brands may be claimed as the property of others.

JAITERAN

101 Innovation Drive, San Jose, CA 95134 now part of Intel


https://www.intel.com/content/www/us/en/docs/programmable/683144/
mailto:FPGAtechdocfeedback@intel.com?subject=Feedback%20on%20(UG-01090%202015.11.17)%20About%20the%20Reed-Solomon%20II%20IP%20Core&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.
https://documentation.altera.com/#/link/mwh1409960636914/mwh1409958250601/en-us
https://documentation.altera.com/#/link/mwh1409960636914/mwh1409958301774/en-us
https://documentation.altera.com/#/link/mwh1409960181641/esc1444754592005/en-us
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html
http://www.altera.com/support/devices/reliability/certifications/rel-certifications.html

. . UG-01090
1-2 DSP IP Core Device Family Support 2015.11.17

« High-performance encoder or decoder for error detection and correction:

« Fully parameterizable:

« Number of channels

« Number of bits per symbol

« Number of symbols per codeword

o Number of check symbols per codeword

« Field polynomial
 Erasures-supporting decoder—-the decoder can correct symbol errors up to the number of check

symbols, if you give the location of the errors to the decoder
 Error symbol output—the decoder provides the error values
« Bit error output—either split count or full count
« Multiple channels for resource sharing

DSP IP Core Device Family Support

Altera® offers the following device support levels for Altera IP cores:

o Preliminary support—Altera verifies the IP core with preliminary timing models for this device family.
The IP core meets all functional requirements, but might still be undergoing timing analysis for the
device family. You can use it in production designs with caution.

« Final support—Altera verifies the IP core with final timing models for this device family. The IP core
meets all functional and timing requirements for the device family. You can use it in production
designs.

Table 1-1: DSP IP Core Device Family Support

Arria® IT GX Final
ArriaI1 GZ Final
ArriaV Final
Arria 10 Final
Cyclone® IV Final
Cyclone V Final
MAX® 10 FPGA Final
Stratix® IV GT Final
Stratix IV GX/E Final
Stratix V Final
Other device families No support
Altera Corporation About the Reed-Solomon Il IP Core
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DSP IP Core Verification

Before releasing a version of an IP core, Altera runs comprehensive regression tests to verify its quality and
correctness. Altera generates custom variations of the IP core to exercise the various parameter options
and thoroughly simulates the resulting simulation models with the results verified against master
simulation models.

Reed-Solomon Il IP Core Release Information
Use the release information when licensing the IP core.

Table 1-2: Release Information

e T iion

Version 15.1
Release Date November 2015
Ordering Code IP-RSCODECII (Primary License)
IPR-RSCODECII (Renewal License)
Product ID 00E5 (Encoder/Decoder)
Vendor ID 6AF7

Altera verifies that the current version of the Quartus Prime software compiles the previous version of
each IP core. Altera does not verify that the Quartus Prime software compiles IP core versions older than
the previous version. The Altera IP Release Notes lists any exceptions.

Related Information

o Altera IP Release Notes
o Errata for Reed-Solomon IP core in the Knowledge Base

Reed-Solomon Il IP Core Performance and Resource Utilization

Table 1-3: Performance and Resource Utilization

Typical expected performance for a Reed-Solomon II IP Core using the Quartus Prime software with the
Arria V (5AGXFB3H4F40C4), Cyclone V (5CGXFC7D6F31C6), and Stratix V (5SGSMD4H2F35C2)
devices.

About the Reed-Solomon Il IP Core Altera Corporation
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Parameters Reglsters
Type Check | BitsPer | BitsPer | ALm M20K Primary | Secondary fMAX
Symbols | Symbol | Check (MHz)
Symbol

ArriaV | Erasures |16 8 204 1,687 1,765 291 217
decoder

ArriaV | Erasures |16 8 204 1,688 1,810 269 213
variable
decoder

ArriaV | Full 16 8 204 952 989 170 239
error
decoder

ArriaV Split 16 8 204 976 999 144 224
error
decoder

ArriaV | Standard | 32 8 255 1,628 1,751 285 215
decoder
large

ArriaV |Standard | 16 8 204 944 974 178 225
decoder
medium

ArriaV |standard |6 4 15 201 272 23 315
decoder
small

ArriaV | Standard | 16 8 204 87 164 0 422
encoder

ArriaV | Variable |16 8 204 964 1,019 174 209
decoder

Arria V | Variable |32 8 204 904 299 0 234
encoder
large

ArriaV | Variable |16 8 204 444 169 0 259
encoder
small

Cyclone |Erasures |16 8 204 1,670 1,769 366 192

\% decoder

Cyclone |Erasures |16 8 204 1,683 1,812 342 196

\Y% variable
decoder

Cyclone Full 16 8 204 953 989 232 215

Vv error
decoder

Altera Corporation
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Parameters Reglsters
Type Check | BitsPer | BitsPer | ALm M20K Primary | Secondary fMAX
Symbols | Symbol | Check (MHz)
Symbol
Cyclone Split 16 8 204 968 1,003 198 209
A\ error
decoder
Cyclone Standard | 32 8 255 1,631 1,752 409 193
\% decoder
large
Cyclone |Standard |16 8 204 938 972 227 222
\% decoder
medium
Cyclone |standard |6 4 15 200 272 56 275
Vv decoder
small
Cyclone |Standard |16 8 204 87 164 0 372
\% encoder
Cyclone | Variable |16 8 204 968 1,016 241 220
Vv decoder
Cyclone |Variable |32 8 204 905 299 0 188
\Y% encoder
large
Cyclone | Variable |16 8 204 444 169 0 217
Vv encoder
small
Stratix V | Erasures |16 8 204 1,648 1,765 423 367
decoder
Stratix V | Erasures |16 8 204 1,664 1,802 405 368
variable
decoder
Stratix V | Full 16 8 204 955 987 252 424
error
decoder
Stratix V. Split 16 8 204 969 1,003 248 424
error
decoder
Stratix V | Standard | 32 8 255 1,624 1,749 432 404
decoder
large
Stratix V | Standard | 16 8 204 939 972 281 410
decoder
medium
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Parameters Reglsters
Type Check | BitsPer | BitsPer | ALm Prlmary Secondary fMAX
Symbols | Symbol | Check (MHz)
Symbol
Stratix V | standard |6 4 15 197 52 525
decoder
small
Stratix V | Standard | 16 8 204 87 164 0 610
encoder
Stratix V | Variable |16 8 204 966 1,017 270 409
decoder
Stratix V | Variable |32 8 204 902 299 0 397
encoder
large
Stratix V | Variable |16 8 204 435 169 0 434
encoder
small
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Licensing IP Cores

The Altera IP Library provides many useful IP core functions for your production use without purchasing
an additional license. Some Altera MegaCore® IP functions require that you purchase a separate license for
production use. However, the OpenCore® feature allows evaluation of any Altera IP core in simulation and
compilation in the software. After you are satisfied with functionality and performance, visit the Self
Service Licensing Center to obtain a license number for any Altera product.

Figure 2-1:IP Core Installation Path

quartus - Contains the Quartus Prime software

ip - Contains the Altera IP Library and third-party IP cores
altera - Contains the Altera IP Library source code
<IP core name> - Contains the IP core source files

Note: The default IP installation directory on Windows is <dri ve>: \ al t er a\ <version number>; on
Linux it is <home directory>l al t er al <version number>.

OpenCore Plus IP Evaluation

Altera's free OpenCore Plus feature allows you to evaluate licensed MegaCore IP cores in simulation and
hardware before purchase. You need only purchase a license for MegaCore IP cores if you decide to take
your design to production. OpenCore Plus supports the following evaluations:

« Simulate the behavior of a licensed IP core in your system.

o Verify the functionality, size, and speed of the IP core quickly and easily.
 Generate time-limited device programming files for designs that include IP cores.
« Program a device with your IP core and verify your design in hardware.

OpenCore Plus evaluation supports the following two operation modes:

« Untethered—run the design containing the licensed IP for a limited time.
o+ Tethered—run the design containing the licensed IP for a longer time or indefinitely. This requires a
connection between your board and the host computer.
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Note: AllIP cores that use OpenCore Plus time out simultaneously when any IP core in the design times
out.

Related Information

o Licensing
o FPGA Software Installation and Licensing

Reed-Solomon Il IP Core OpenCore Plus Timeout Behavior

All TP cores in a device time out simultaneously when the most restrictive evaluation time is reached. If a
design has more than one IP core, the time-out behavior of the other IP cores may mask the time-out
behavior of a specific IP core .

For IP cores, the untethered time-out is 1 hour; the tethered time-out value is indefinite. Your design stops
working after the hardware evaluation time expires. The Quartus Prime software uses OpenCore Plus Files
(. ocp) in your project directory to identify your use of the OpenCore Plus evaluation program. After you
activate the feature, do not delete these files..

When the evaluation time expires, for encoders out _dat a goes low, r st goes high; for decoders, dat a goes
low, r st goes high .

Related Information
AN 320: OpenCore Plus Evaluation of Megafunctions

IP Catalog and Parameter Editor
The IP Catalog (Tools > IP Catalog) and parameter editor help you easily customize and integrate IP
cores into your project. Use the IP Catalog and parameter editor to select, customize, and generate files

representing the custom IP variation in your project.

P Catalog q Filter IP by device
Device Family [Amia 10 (GX/SX/GT) ~]

[« x-=]l Search for installed IP
- 2 Installed IP Refresh IP catalog F5

- Project Directory
No Selection Available v Show IP for all device families

= Library Show IP for active device family

S8 Basic Functions

+ Arithmetic
+ Bridges and Adaptors
-/ Clocks; PLLs and Resets
# ALTCLKCTRL e

| * Double-click to customize
Conguraon and P1," [, right-click for details
|_oewass ]

/o
Miscellaneous ALTCLKCTRY (acikes)

On Chip Memory

Simulation; Debug and Verification * insased version 151
Supported Device Families: Ania Il G2, Amia V. Amia V GZ, Cyclone IV E. Cyclone V.

Alera Comorason

o

+

+ DsSP

Ama 10, Ama I GX, Cyclone IV GX, Swatix V., Srasx IV,
+ Interface Protocols MAX 10
+ Low Power Locason’ Mools/acdv/15 L1, sonalickctiaRclken_twich
+ Memory Interfaces and Controllers e
+ Processors and Peripherals Usor Guide

+ University Program
0 Search for Partner IP

Release Notes

+ Add
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The IP Catalog displays the installed IP cores available for your design. Double-click any IP core to launch
the parameter editor and generate files representing your IP variation. Use the following features to help
you quickly locate and select an IP core:

« Filter IP Catalog to Show IP for active device family or Show IP for all device families. If you have no
project open, select the Device Family in IP Catalog.

« Type in the Search field to locate any full or partial IP core name in IP Catalog.

+ Right-click an IP core name in IP Catalog to display details about supported devices, open the IP core's
installation folder, and click links to IP documentation.

« Click Search for Partner IP, to access partner IP information on the Altera website.

The parameter editor prompts you to specify an IP variation name, optional ports, and output file
generation options. The parameter editor generates a top-level Qsys system file (. gsys) or IP file (. qi p)
representing the IP core in your project. You can also parameterize an IP variation without an open
project.

The IP Catalog is also available in Qsys (View > IP Catalog). The Qsys IP Catalog includes exclusive
system interconnect, video and image processing, and other system-level IP that are not available in the IP
Catalog. For more information about using the Qsys IP Catalog, refer to Creating a System with Qsys in the
Handbook.

Note: The IP Catalog (Tools > IP Catalog) and parameter editor replace the MegaWizardW Plug-In
Manager for IP selection and parameterization, beginning in Quartus II software version 14.0. Use
the IP Catalog and parameter editor to locate and paramaterize Altera IP cores.

Reed-Solomon Il IP Core Getting Started Altera Corporation
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You can quickly configure a custom IP variation in the parameter editor. Use the following steps to specify
IP core options and parameters in the parameter editor.

Figure 2-2: IP Parameter Editor

File Edit System Generate Yiew Tools Help

E Parameters §I

. IP Parameter Editor - unsaved.qsys* (/users/jbrossar/150 migrate upgrade _test/unsaved.qsys) <@sj-slscf2680-02>

== | 'iﬁ Details ¥ Block Symbol 8’3_

Create IP Variation

* Settings

-
System: unsaved  Path: xovr_fpll_2l0.0 =
Arria 10 fPLL '+ 1 |Arria 10 fPLL =
ahtera_xcw_fpll_alo
T ——— il Name altera_xcvr_fpll_al0
[ Dynamic Reconfiguration | Generation Options } Advanced Parameters | .
PLL 1 Master Clock Generation Block | Version 151
‘ Author Altera Corporation
= General
: Description Arria 10 FPLL.
FPLL Mode: Transceiver l.'J pt
. =T Group Interface Protocols/Tran
Protocol mode: Basic :].,1
Data Sheet http:/ fwwr.altera.com/l
[_] Enable fractional mode = ’ :
User Guide https:ffdocumentation.a
[[] Enable manual counter configuration |
Release Notes ; men 8
[C] Enable ATX to FPLL cascade clock input port £l 1»
[* Reference Clock ] A...... X[ J[.>
Desired reference clock frequency: [100_0 | MHz r— o
Actual reference clock frequency: G Presets % | -
Number of PLI New IP Variation <@sj-slscf2680-02> (mil 8= for xcwr_fpll_al0_0
selected referf YOUr IP settings will be saved in a .gsys file. x;

k New... to create a preset

Bandwicith: Entity name: |un narmed

| GX 2500Mbps Bonded

4] Sawe in folder: |;users.fjbrossar;JSO_migrate-upgrade,lest

|U GX 2500Mbps Single Channel

F?E Messages Target Device

GX 2500Mbps %N Non-Bonded

Type Family. |arria 10

(X ] 1in|

Device: |10A5016(3U19E2LC.

@ ung

|@ Info: Your IP will be saved in fusersjjbrossar/150_migrate_upgrade_test/unnamed.qsys

PCle Genl and Gen2 Multi Lane 100Mhz
| | f pcte Gent ana Genz single Lane 100Mnz

4 4] I

o] B | Updare | Delete

0 Errors, O Warry

Specify your IP variation name -
and target device

Apply preset parameters for
specific applications

Generate HOL.. || Fjﬁish |

............ View IP port

and parameter
details

1. In the IP Catalog (Tools > IP Catalog), locate and double-click the name of the IP core to customize.

The parameter editor appears.

2. Specity a top-level name for your custom IP variation. The parameter editor saves the IP variation
settings in a file named <your_ip>. qsys. Click OK. Do not include spaces in IP variation names or

paths.

3. Specify the parameters and options for your IP variation in the parameter editor, including one or
more of the following. Refer to your IP core user guide for information about specific IP core

parameters.

Altera Corporation
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« Optionally select preset parameter values if provided for your IP core. Presets specify initial
parameter values for specific applications.

o Specify parameters defining the IP core functionality, port configurations, and device-specific
features.

« Specify options for processing the IP core files in other EDA tools.

. Click Generate HDL. The Generation dialog box appears.
. Specify output file generation options, and then click Generate. The IP variation files generate

according to your specifications.

. To generate a simulation testbench, click Generate > Generate Testbench System.
. To generate an HDL instantiation template that you can copy and paste into your text editor, click

Generate > HDL Example.

. Click Finish. Click Yes if prompted to add files representing the IP variation to your project. Optionally

turn on the option to Automatically add Quartus Prime IP Files to All Projects. Click Project >
Add/Remove Files in Project to add IP files at any time.

Figure 2-3: Adding IP Files to Project

Auto adds
IP without

¥ Quartus Prime IP Files <@sj-slscf2680-02>

When you create an Aliera IP variation, a Quartus Prime IP File is
generated. Quartus Prime IP Files are used to represent the Altera IP in
your design. Do you want 1o add the Quarus Prime [P File to the
project?

B jusersijbrossanip_15L/pcie_gen3_xB_2inst_ni_restored/my_al...

I [Automatically add Quarus Prime IP Files to all projects|

(Note: Tuming on this opion permanently suppresses this dialog box
You can change this setfing in the Options dialog box)

¥es No Help

For Arria 10 devices and newer, the generated . qsys file must be added to your project to represent IP
and Qsys systems. For devices released prior to Arria 10 devices, the generated . qi p and . si p files
must be added to your project for IP and Qsys systems.

The generated . gsys file must be added to your project to represent IP and Qsys systems.

. After generating and instantiating your IP variation, make appropriate pin assignments to connect

ports.

Related Information

FPGA IP Documentation Index
Altera IP Release Notes

Files Generated for Altera IP Cores and Qsys Systems

The software generates the following output file structure for IP cores and Qsys systems. For Arria 10
devices and newer, the generated . qsys file must be added to your project to represent IP and Qsys
systems. For devices released prior to Arria 10 devices, the generated . gi p and . si p files must be added
to your project to represent IP and Qsys systems. The software generates the following output file structure
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for IP cores and Qsys systems. The generated . qsys file must be added to your project to represent IP and
Qsys systems.

Figure 2-4: Files generated for IP cores and Qsys Systems

(] <Project Directory>

<your_ip>.qip or .qsys - System or IP integration file

<your_ip>.sopcinfo - Software tool-chain integration file

<your_ip> - IP core variation files
{]<your_ip>.bsf - Block symbol schematic file
{]<your_ip>.cmp - VHDL component declaration
{]<your_ip>.debuginfo - Post-generation debug data
%G<your_ip>.html - Memory map data
*ﬂ<your_ip>.ppf - XML1/0 pin information file
%G<your_ip>.qip - Lists files for IP core synthesis
—G<your_ip>.sip - NativeLink simulation integration file
{]<your_ip>.spd - Combines individual simulation startup scripts !
*[]<your_ip>_bb.v - Verilog HDL black box EDA synthesis file
{] <your_ip>_generation.rpt - IP generation report
kﬂ <your_ip>_inst.v or .vhd - Lists file for IP core synthesis

sim - IP simulation files
<your_ip>.v or vhd - Top-level simulation file

<simulator vendor> - Simulator setup scripts
<simulator_setup_scripts>

synth - IP synthesis files
<your_ip>.v or .vhd - Top-level IP synthesis file

1 ]<IPSubmodule> - IP Submodule Library
sim- IP submodule 1 simulation files

<HDL files>
synth - IP submodule 1 synthesis files
<HDL files>
—1 | <your_ip>_th - IP testhench system

1

<your_testbench>_th.qsys - testbench system file
<your_ip>_th - IP testbench files

<your_testbench>_th.csv or .spd - testbench file
sim - IP testbench simulation files

1. If supported and enabled for your IP core variation.
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Table 2-1: IP Core and Qsys Simulation Generated Files

“

<ny_I p>. qsys The Qsys system or top-level IP variation file. <my_ip> is the name
that you give your IP variation. You must add the .qsys file to your
Quartus project to enable NativeLink for Arria 10 and Stratix 10
device families.

The Qsys system or top-level IP variation file. <my_ip> is the name
that you give your IP variation.

<syst enp. sopci nfo Describes the connections and IP component parameterizations in
your Qsys system. You can parse its contents to get requirements
when you develop software drivers for IP components.

Downstream tools such as the Nios II tool chain use this file.

The .sopci nf o file and the syst em h file generated for the Nios II
tool chain include address map information for each slave relative to
each master that accesses the slave. Different masters may have a
different address map to access a particular slave component.

<ny_i p>. cnp The VHDL Component Declaration (.cmp) file is a text file that
contains local generic and port definitions that you can use in VHDL
design files.

<my_i p>. htnl

A report that contains connection information, a memory map
showing the address of each slave with respect to each master to
which it is connected, and parameter assignments.

<my_i p>_generati on. rpt IP or Qsys generation log file. A summary of the messages during IP
generation.
<my_i p>. debugi nfo Contains post-generation information. Used to pass System Console

and Bus Analyzer Toolkit information about the Qsys interconnect.
The Bus Analysis Toolkit uses this file to identify debug components
in the Qsys interconnect.

<ny_i p>. qi p Contains all the required information about the IP component to
integrate and compile the IP component in the software.

<my_i p>. csv Contains information about the upgrade status of the IP component.

<ny_i p>. bsf A Block Symbol File (.bsf) representation of the IP variation for use
in Block Diagram Files (.bdf).

<ny_i p>. spd Required input file for i p- make- si mscri pt to generate simulation
scripts for supported simulators. The .spd file contains a list of files
generated for simulation, along with information about memories

that you can initialize.

<nmy_i p>. ppf The Pin Planner File (.ppf) stores the port and node assignments for
IP components created for use with the Pin Planner.

<ny_i p>_bb. v You can use the Verilog black-box (_bb.v) file as an empty module
declaration for use as a black box.
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m
<ny_ip>sip Contains information required for NativeLink simulation of IP

components. You must add the .sip file to your Quartus project to
enable NativeLink for Arria II, Arria V, Cyclone IV, Cyclone V, MAX
10, MAX II, MAXV, Stratix IV, and Stratix V devices.

<my_i p>_i nst.vor_inst.vhd | HDL example instantiation template. You can copy and paste the
contents of this file into your HDL file to instantiate the IP variation.

<ny_i p>. regnap If the IP contains register information, the .regmap file generates.
The .regmap file describes the register map information of master
and slave interfaces. This file complements the .sopcinfo file by
providing more detailed register information about the system. This
enables register display views and user customizable statistics in
System Console.

<ny_i p>. svd Allows HPS System Debug tools to view the register maps of
peripherals connected to HPS within a Qsys system.
During synthesis, the .svd files for slave interfaces visible to System
Console masters are stored in the .sof file in the debug section.
System Console reads this section, which Qsys can query for register
map information. For system slaves, Qsys can access the registers by
name.

<ny_ip>.v HDL files that instantiate each submodule or child IP core for

or synthesis or simulation.

<my_i p>. vhd

ment or/ Contains a ModelSim® script msi m set up. t ¢l to set up and run a
simulation.

al dec/ Contains a Riviera-PRO script ri vi er apr o_set up. t ¢l to setup
and run a simulation.

/ synopsys/ vcs Contains a shell script vcs_set up. sh to set up and run a VCS®

simulation.
/ synopsys/ vcsnx

Contains a shell script vesnx_set up. sh and synopsys_
si m set up file to set up and run a VCS MX® simulation.

/'cadence Contains a shell script ncsi m set up. sh and other setup files to set
up and run an NCSIM simulation.
/ subnodul es Contains HDL files for the IP core submodule.
<I P subrodul e>/ For each generated IP submodule directory, Qsys generates / synt h
and / si msub-directories.
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Simulating Altera IP Cores in other EDA Tools

The software supports RTL and gate-level design simulation of Altera IP cores in supported EDA
simulators. Simulation involves setting up your simulator working environment, compiling simulation

model libraries, and running your simulation.

You can use the functional simulation model and the testbench or example design generated with your IP
core for simulation. The functional simulation model and testbench files are generated in a project
subdirectory. This directory may also include scripts to compile and run the testbench. For a complete list
of models or libraries required to simulate your IP core, refer to the scripts generated with the testbench.

You can use the NativeLink feature to automatically generate top-level simulation scripts. NativeLink
launches your preferred simulator from within the software. You can use the i p- set up- si nul at i on utility
to generate a unified, version-agnostic IP simulation script for all Altera IP cores in your design. You can
incorporate the IP simulation scripts into your top-level script.

You can use the i p- set up- si nul at i on utility to generate a unified, version-agnostic IP simulation script
for all Altera IP cores in your design. You can incorporate the IP simulation scripts into your top-level

script.

Figure 2-5: Simulation in Design Flow

Quartus Prime
Design Flow

Analysis & Synthesis

(place-and-route)

TimeQuest Timing Analyzer

Device Programmer

(HDL, Qsys, DSP Builder)

Design Entry

EDA
Netlist
Writer

Altera Simulation

Models

l

RTL Simulation

L

Post-synthesis functional
simulation netlist

Gate-Level Simulation

Post-synthesis

Post-fit functional
simulation netlist

functional
simulation

> Post-fit functional

Post-fit timing
simulation netlist

simulation

(Optional) Post-fit

A 4

timing simulation

Note: Post-fit timing simulation is supported only for Stratix IV and Cyclone IV devices in the current
version of the software. The Pro Edition software does not support NativeLink RTL simulation.
Altera IP supports a variety of simulation models, including simulation-specific IP functional
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Note:

simulation models and encrypted RTL models, and plain text RTL models. These are all cycle-
accurate models. The models support fast functional simulation of your IP core instance using
industry-standard VHDL or Verilog HDL simulators. For some cores, only the plain text RTL
model is generated, and you can simulate that model. Use the simulation models only for
simulation and not for synthesis or any other purposes. Using these models for synthesis creates a
nonfunctional design.

Altera IP supports a variety of simulation models, including simulation-specific IP functional
simulation models and encrypted RTL models, and plain text RTL models. These are all cycle-
accurate models. The models support fast functional simulation of your IP core instance using
industry-standard VHDL or Verilog HDL simulators. For some cores, only the plain text RTL
model is generated, and you can simulate that model. Use the simulation models only for
simulation and not for synthesis or any other purposes. Using these models for synthesis creates a
nonfunctional design.

Related Information

Simulating Altera Designs

DSP Builder Design Flow

DSP Builder shortens digital signal processing (DSP) design cycles by helping you create the hardware
representation of a DSP design in an algorithm-friendly development environment.

This IP core supports DSP Builder. Use the DSP Builder flow if you want to create a DSP Builder model
that includes an IP core variation; use IP Catalog if you want to create an IP core variation that you can
instantiate manually in your design.

Related Information
Using MegaCore Functions chapter in the DSP Builder Handbook.

Altera Corporation
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This topic describes the IP core’s architecture, interfaces, and signals.

Architecture

You can parameterize the Reed-Solomon II IP core as an encoder or a decoder. The encoder receives data

packets and generates the check symbols; the decoder detects and corrects errors.

Reed-Solomon Il Encoder

When the encoder receives data symbols, it generates check symbols for a given codeword and sends the
input codeword together with the check symbols to the output interface. The encoder uses backpressure on
the upstream component when it generates the check symbols.

Figure 3-1: Reed-Solomon Il Codeword Encoding
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Figure 3-2: Encoder Timing—One Channel

Shows the timing diagram of the RS II encoder with one channel.

dk_ck LUy Wy gy

reset_reset n | ) \)
in_valid [ \) 1)
in_startofpacket [ i\ | ) \
in_endofpacket 5 [ §
in_data[7:0] 0 [T 2 I3 45 678923 4]s 6 17 [18\B4237[38[239] W1 213714
in_ready [ ) I | W
out_valid | [ ) \)
out_startofpacket | [ §\ § L
out_endofpacket | i\ i\ 1
out_data[7:0] ] 0 [T T2 03 1456789 0] 2]13]14]715]16V93%42351236)237]238] 239\ 114[ 6130 244 75] 1 [ 2]
out_ready }) )

The i n_st art of packet signal starts a codeword; the i n_endof packet signals its termination. An
asserted i n_val i d signal indicates valid data. The i n_st art of packet signal is only valid when you assert
the i n_val i d signal. For a 1-channel codeword, assert the i n_st art of packet and i n_endof packet
signals for one clock cycle. The encoder uses backpressure by deasserting the i n_r eady signal when it
receives the i n_endof packet signal. During this time, the encoder signals that it cannot accept more
incoming symbols and generates the check symbols for the current codeword. The IP core does not verify
if the number of symbols (N) exceeds the maximum symbols per codeword. You must ensure that the
codeword sent to the core has a valid N. The r eset _r eset _n signal is active low and you can assert this
signal asynchronously. However, you have to deassert the r eset _r eset _n signal synchronously with the
cl k_cl k signal.

Shortened Codewords

The RS IT IP core supports shortened codewords. A shortened codeword contains fewer symbols than the
maximum value of N, which is 2M -1, where N is the total number of symbols per codeword and M is the
number of bits per symbol. A shortened codeword is mathematically equivalent to a maximum-length
code with the extra data symbols at the start of the codeword set to 0. For example, (204,188) is a
shortened codeword of (255,239). Both of these codewords use the same number of check symbols, 16. To
use shortened codewords with the decoder, use the parameter editor to set the codeword length to the
correct value; for the encoder assert endofpacket once it generates enough symbols.

Reed-Solomon Il Decoder

When the decoder receives the encoded codeword, it uses the check symbols to detect errors and correct
them.
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Figure 3-3: Codeword Decoding
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The received encoded codeword may differ from the original codeword due to the noise in the channel.
The decoder detects errors using several polynomials to locate the error location and the error value.
When the decoder obtains the error location and value, the decoder corrects the errors in a codeword, and
sends the codeword to the output. As the number of errors increases, the decoder gets to a stage where it
can no longer correct but only detect errors, at which point the decoder asserts the out _error signal.

Table 3-1: Decoder Detection and Correction

Lists how the decoder corrects and detects errors (e) depending on the number of check symbols (R).

e<R/2 Decoder detects and corrects errors.

Ri2<e Decoder asserts error signal and decoding fails. The
probability that the decoder might not assert the
error signal is less than 1/t.

For small numbers of check symbols, out _error is not always reliable. RS codewords have at least d
different symbols: d = R + 1. A received packet containing e errors can be either the transmitted codeword
t1 with e errors, or another valid codeword 2 with d—e errors (if 12 exists). When e> R/2, the received
packet looks more like 2 than 1 (because d - e < e) so, the decoder outputs t2 and does not assert

out _error. The probability that 2 exists is inferior or equal to the inverse of factorial of R/2. It decreases
exponentially as R increases, but is nonetheless significant for small numbers of check symbols.
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Figure 3-4: Decoder Timing—One Channel

shows the timing diagram of the RS II decoder with one channel.
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The codeword starts when you assert the i n_val i d signal and the i n_st art of packet signal. The decoder
accepts the data ati n_dat a as valid data. The codeword ends when you assert the i n_endof packet signal.
For a 1-channel codeword, assert the i n_st ar t of packet and i n_endof packet signals for one clock cycle.
When the decoder deasserts the i n_r eady signal, the decoder cannot process any more data until it asserts
the i n_r eady signal again.

At the output, the operation is identical. When the decoder asserts the out _val i d signal and the

out _start of packet signal, the decoder provides valid data on out _dat a. The decoder asserts the

out _start of packet signal and the out _endof packet signal to indicate the start and end of a codeword.
The decoder automatically detects and corrects errors in a codeword and asserts the out _error signal
when it encounters a non-correctable codeword. The decoder outputs the full codeword including the
check symbols, which you should remove.

Variable Decoding

Under normal circumstances, the decoder allows variable decoding, so you can change the number of
symbols per codeword (N) using si nk_eop, but not the number of check symbols while decoding.
However, you cannot change the length of the codeword, if you turn on the erasure-supporting option. If
you turn on the variable option, you can vary:

« The number of symbols per codeword (using the numm signal) and the number of check symbols (using
the nuncheck signal), in real time.

+ Both from their minimum allowable values up to their selected values, even with the erasures-
supporting option turned on.

Multiple Input Channels

The RS II IP core processes multiple input channels simultaneously.

The IP core receives codewords in a fixed pattern. Symbols coming in through the channels are
interleaved. The IP core samples the first symbol of channel one on the first rising clock edge, then the first
symbol of channel two on the second rising clock edge, etc. Both information and check symbols are
output in the same sequence.
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Figure 3-5: Codeword for CChannels and N/Symbols

The channel signal indicates the channel associated to the current symbol. The channel sequence is fixed.
st art of packet indicates the first symbol of a codeword per channel. For a C-channel codeword,

st art of packet must be high for C consecutive cycles. endof packet indicates the last symbol of a
codeword per channel. For a C-channel codeword, endof packet must be high for C consecutive cycles.

valid |
startofpacket I—l—
endofpacket
chamel | o [ 1 [ o [ 1 ] w o v e o [ oo ] ]
data [hON-1 [ ch 1 N-1[ ch N[ chh-] = o1 Tt [ choo Jch1o JehoNrfrina] ™

le N|

r Codeword 0 i

v

Codeword 1

Note: The st art of packet and endof packet governs the number of symbols per codeword, N. The IP
core does not verify if N exceeds the maximum symbols per codeword. The IP core also does not
verify the channel or data pattern. You must ensure that the codeword sent to the IP core has a valid
N and a valid pattern.

Figure 3-6: Encoder Timing—Two Channels

For a two-channel codeword, the encoder asserts the i n_st art of packet and i n_endof packet signals for
two consecutive cycles.
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Figure 3-7: Decoder Timing—Two Channels

For a two-channel codeword, the decoder asserts the i n_st ar t of packet and i n_endof packet signals for
two consecutive cycles.
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Table 3-2: Parameters

Reed-Solomon Encoder or Decoder | Encoder Specifies an encoder or a decoder.

Number of 1to 16 1 Specifies the number of input channels (C)

channels to process. The channel pattern is fixed.

Number of bits per |3 to 12 8 Specifies the number of bits per symbol

symbol (M).

Number of symbols | 1 to 2M-1 255 Specifies the total number of symbols per

per codeword codeword (N). The decoder accept a new
symbol every clock cycle if 6.5R < N. If N>
=6.5R+1, the decoder shows continuous
behavior.

Number of check | 1to N-1 16 Specifies the number of check symbols per

symbols per codeword (R).

codeword

Field Polynomial | Any valid polynomial |285 Specifies the primitive polynomial defining
the Galois field. The parameter editor
allows you to select only legal values. If you
cannot find your intended field
polynomial, contact Altera MySupport.

Altera Corporation
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Type of generator | Classical or CCSDS- Classical Specifies the representation of the

polynomial like generator polynomial.

First root of the 1to 2M-2 0 Specifies the first root of the generator

polynomial polynomial.

generator

Root spacing in the | Any primitive 1 Specifies spacing between roots in the

polynomial elements in the field generator polynomial.

generator

Erasures- On or off Ooff Specifies the erasures-supporting decoder.

supporting decoder This option substantially increases the
logic resources the design uses.

Variable codeword |On or off off Specifies variable codeword length with

length num signal. When oft, the latency equation
is: L= N + 6.5R+8

Control signal sop or eop or in_numn | in_numn Specifies how to pass the codeword length

signal to the IP core

Optimization type |Latency or resource Latency Select resource, so the latency always
corresponds to that of the largest possible
codeword. Select latency, so the latency
corresponds to the current codeword.

Variable number of | On or off off Specifies check symbols with nuncheck

check symbols signal.

Error symbol value |On or oft On Specifies whether the decoder indicates the
error symbols.

Error symbol count | On or oft On Specifies whether the decoder indicates the
number of error symbols per codeword.

Error bit count On or off On Specifies whether the decoder indicates the
number of error bits per codeword.

Error bits count Full or split Full Specifies full or split count:

format

« With full count the decoder just counts
the number of received error bit

« With split count the decoder counts the
number of received error bits with
initial value "1" (then corrects to value
"0") and outputs num error_bit1.1It
also counts the number of received
error bits with initial value "0" (then
corrects to the value "1") and outputs
numerror_bitO
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Reed-Solomon Il IP Core Interfaces and Signals

The RS II Avalon-ST interface supports backpressure, which is a flow control mechanism, where a sink can
indicate to a source to stop sending data.

The ready latency on the Avalon-ST input interface is 0; the number of symbols per beat is fixed to 1.

The clock and reset interfaces drive or receive the clock and reset signal to synchronize the Avalon-ST
interfaces and provide reset connectivity. The status interface is a conduit interface that consists of three
error status signals for a codeword. The decoder obtains the error symbol value, number of error symbols,
and number of error bits in a codeword from the status signals.

Avalon-ST Interfaces in DSP IP Cores

Avalon-ST interfaces define a standard, flexible, and modular protocol for data transfers from a source
interface to a sink interface.

The input interface is an Avalon-ST sink and the output interface is an Avalon-ST source. The Avalon-ST
interface supports packet transfers with packets interleaved across multiple channels.

Avalon-ST interface signals can describe traditional streaming interfaces supporting a single stream of
data without knowledge of channels or packet boundaries. Such interfaces typically contain data, ready,
and valid signals. Avalon-ST interfaces can also support more complex protocols for burst and packet
transfers with packets interleaved across multiple channels. The Avalon-ST interface inherently synchro-
nizes multichannel designs, which allows you to achieve efficient, time-multiplexed implementations
without having to implement complex control logic.

Avalon-ST interfaces support backpressure, which is a flow control mechanism where a sink can signal to
a source to stop sending data. The sink typically uses backpressure to stop the flow of data when its FIFO
buffers are full or when it has congestion on its output.

Related Information

Avalon Interface Specifications

Reed-Solomon Il IP Core Signals

Table 3-3: Clock and Reset Signals

clk_clk Input The main system clock. The whole IP core operates
on the rising edge of cl k_cl k .

reset _ reset_n Input An active low signal that resets the entire system
reset_n when asserted. You can assert this signal asynchro-
nously. However, you must deassert it synchronous
to the cl k_cl k signal. When the IP core recovers
from reset, ensure that the data it receives is a
complete packet.

Altera Corporation Reed-Solomon Il IP Core Functional Description
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Table 3-4: Avalon-ST Input and Output Interface Signals

i n_r eady r eady Output Data transfer ready signal to indicate that the sink is
ready to accept data. The sink interface drives the

i n_r eady signal to control the flow of data across
the interface. The sink interface captures the data
interface signals on the current cl k rising edge.

in_valid valid Input Data valid signal to indicate the validity of the data
signals. When you assert the i n_val i d signal, the
Avalon-ST data interface signals are valid. When
you deassert the i n_val i d signal, the Avalon-ST
data interface signals are invalid and must be
disregarded. You can assert the i n_val i d signal
whenever data is available. However, the sink only
captures the data from the source when the IP core
asserts the i n_r eady signal.

i n_data[] data Input Data input for each codeword, symbol by symbol.
Valid only when you assert the i n_val i d signal. For
Qsys systems, the i n_dat a bus is: [i n_num,i n_
nuntheck,dat a] If you have no variable check it is:
[num,dat a]

For example, for a maximum codeword length of
255 corresponding to 8 bits:

e in_data[7:0] =data

e in_data[15:0] =num

i n_channel |channel Input Specifies the channel number for data the IP core
transfers on the current cycle. The i n_channel
signal is available only when you configure the IP
core to support multiple channels.

in_startof- |sop Input Start of packet (codeword) signal.
packet
in_ eop Input End of packet (codeword) signal.

endof packet

in_error error Input Error signal. Specifies if the input data symbol is an
error and whether the decoder can consider it as an
erasure. Erasures-supporting decoders only.

out _ sop Output Start of packet (codeword) signal. This signal
start of - indicates the codeword boundaries on the i n_
packet dat a[ ] bus. When the IP core drives this signal

high, it indicates that the start of packet is present
onthein_data[] bus. The IP core asserts this
signal on the first transfer of every codeword.

Reed-Solomon Il IP Core Functional Description Altera Corporation
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Output End of packet (codeword) signal. This signal
endof packet indicates the packet boundaries on the i n_dat a[ ]

bus. When the IP core drives this signal high, it
indicates that the end of packet is present on the i n_
dat a[ ] bus. The IP core asserts this signal on the
last transfer of every packet.

out _ready r eady Input Data transfer ready signal to indicate that the
downstream module is ready to accept data. The
source provides new data (if available) when you
assert the out _r eady signal and stops providing
new data when you deassert the out _r eady signal.
If the source is unable to provide new data, it
deasserts out _val i d for one or more clock cycles
until it is prepared to drive valid data interface
signals.

out_valid valid Output Data valid signal. The IP core asserts the out _val i d
signal high, whenever a valid output is on out _

dat a ; the IP core deasserts the signal when there is
no valid output on out _dat a .

out _data data Output Contains decoded output when the IP core asserts
the out _val i d signal. The corrected symbols are in
the same order that they are entered.

out _channel |channel Output Specifies the channel whose result is presented at
out _dat a . Available only when you configure the
IP core to support multiple channels.

out _error error Output Indicates non-correctable codeword (decoder only).
Valid when the IP core asserts out _endof packet .

Table 3-5: Configuation Signals

e T i T oo

num check Output Sets the variable number of check symbols up
to a maximum value set by the parameter R
(variable option only).

num Output Variable value of N. Can be any value from the
minimum allowable value of N up to the
selected value of N (variable and erasures-
supporting option only).

Table 3-6: Status Interface Signals

status_error_val ue |conduit Output Error correction value for every
valid data symbol.
Altera Corporation Reed-Solomon Il IP Core Functional Description
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status_num error_ condui t Output Number of error symbols in a
synbol codeword. This signal is valid

when the IP core asserts out _
endof packet . Only available
when you turn on Error symbol

count .
status_numerror_ condui t Output Number of error bits in a
bi t codeword. This signal is valid

when the IP core asserts the out _
endof packet . Only available
when you turn on Error bit count
and select Full for Error bits
count format .

status_num error_ condui t Output Number of bit errors for the

bito correction from bit 1 to bit 0. The
latest is the correct bit. This signal
is valid when the IP core asserts
the out _endof packet . Only
available when you turn on Error
bit count and select Split for
Error bits count format .

status_numerror_ condui t Output Number of bit errors for the

bito correction from bit 0 to bit 1. The
latest is the correct bit. This signal
is valid when the IP core asserts
the out _endof packet . Only
available when you turn on Error
bit count and select Split for
Error bits count format .

Reed-Solomon Il IP Core Functional Description Altera Corporation
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